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EXECUTIVE SUMMARY 

This document provides instructions and guidelines for drafting technical reports for OSPD.  It is 

intended to complement a Microsoft® Word report template that is available for authors when 

drafting a report.  Authors should contact the appropriate BSEE Contracting Officer’s 

Representative (COR) or Contracting Officer (CO) to address questions or potential deviations of 

the report requirements outlined in this document.  See Section 4.5 regarding expected content 

and format of an Executive Summary.   
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1 Introduction 

The Bureau of Safety and Environmental Enforcement (BSEE) Oil Spill Preparedness Division 

(OSPD) Report Specifications provides guidance and serves as a model for preparing reports. 

This document clarifies the guidelines for authors, contractors, Contracting Officer’s 

Representatives (CORs), and editors. The term “contractors” encompasses all entities preparing 

OSPD reports through a contract, inter/intra-agency agreement, or cooperative agreement. These 

specifications apply to all OSPD reports regardless of contractor type. 

 

Deviations from these specifications require approval by the BSEE OSPD COR during the first 

draft stage of the report. 

 

These specifications may be updated at any time. BSEE OSPD prefers contractors follow the 

specifications in place at the time the deliverable is being prepared, not those at the time of the 

award. 

 

OSPD reports must be professional in appearance, reviewed for technical accuracy, and edited 

by the author(s) or contractor(s) for clear language and compliance with these specifications.  

 

Reports should comply with Section 508 of the Rehabilitation Act; see 

https://www.section508.gov/ for more information. BSEE recommends that contractors utilize 

the “Check Accessibility” function in Microsoft® Word. 

 

To assist contractors in complying with these specifications, BSEE OSPD developed the 

Microsoft® Word OSPD Report Template (Template), which is available through the project 

COR or can be downloaded from www.bsee.gov. 
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2 Style Guide 

Contractors are strongly encouraged to follow the Council of Science Editor’s (CSE’s) 
Scientific Style and Format: The CSE Manual for Authors, Editors, and Publishers 8th Edition 
(CSE 8th Edition) (CSE 2014). Part 4 of the CSE 8th Edition, Technical Elements of Publications, 
is of particular pertinence for OSPD reports, which BSEE OSPD considers to be technical 
reports or monographs. Table 1 lists the elements of these reports, where to find guidance in the 
CSE, and whether or not BSEE OSPD provides additions and/or exceptions to the CSE 8th 

Edition in this document. 

Section in This 
Document 

Report Element CSE 8th Edition 
Section 

Addition and/or 
Exception to CSE 

3.0 Report Format 

3.1 File Format  ✓ 

3.2 Page Size  ✓ 

3.3 Page Margins  ✓ 

3.4 Page Numbers 28.5.1 
 

✓ 

4.0 Report Sections   

4.1 Front Cover 28.6.1.1 ✓ 

4.2 Title Page 28.6.1.1.2 ✓ 

4.3 Notices 3.1.5.3, 28.4.2.4.8, 
28.6.1.1.3 

✓ 

4.4 Graphical Abstract 27.7.1.4, 28.6.1.1.5 ✓ 

4.5 Executive Summary 28.6.1.2.1  

4.6
 

Table of 
Contents and 
Other Front 
Matter Lists

 
28.4.2.6, 
28.4.2.8

 
 

Table of Contents and Other Front Matter Lists 28.4.2.6, 28.4.2.8 ✓ 

4.7 Report Body   

4.8 References 28.4.4.5, 28.6.1.3, 
29.1, 29.3, 
29.2.1.2, 29.3 

 

4.9 Appendixes 28.4.4.2, 28.6.1.3  

4.10 Abbreviations, Acronyms, and Symbols 11, 28.4.2.11.4, 
28.6.1.3 

✓ 

4.11 Back Cover 28.4.1 ✓ 

4.12 Multiple Volumes 27.5 ✓ 

5.0 Report Body Style Specifications   

5.1 Spacing  ✓ 

5.2 Paragraph Formatting  ✓ 

5.3 Fonts 31.2.1 ✓ 

5.4 Numbers  12.1.3,13.3 ✓ 

5.5 Units 12.2.1 ✓ 

5.6 Tables and Figures 30.1, 30.2 ✓ 

5.7 Hyperlinks 29.3.7.13 ✓ 

5.8 Endnotes and Footnotes 27.7.2.3 ✓ 

Table 1 OSPD report elements and their relation to CSE 8th Edition 
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3 Report Format 

3.1 File Format 

Prepare document deliverables using the word processing software and version in use by BSEE 

OSPD. OSPD is currently using the Office 365 version of Word. Preparers may use Office 365, 

or with approval from OSPD, previous versions of Word. The Microsoft® Word version of the 

final report must include all components in a single file, with three levels of bookmarks 

corresponding to the report sections. The final report must also be provided in PDF format, with 

three levels of bookmarks for the report sections. Alternative text should also be included in the 

PDF. When saving the Word document as a PDF, change the Save as Type to “PDF”.  Under 

Options, make sure to check “Create bookmarks using: Headings” and “Document structure tags 

for accessibility”. There is no size limitation on the final report files.  

3.2 Page Size 

Use letter-sized pages (8.5 by 11.0 inch). 

3.3 Page Margins 

Set page margins at 1.0 inch on all sides. All body text, figures, and tables must fit within the 

page margins. Page numbers and footnotes can be included in the footer.  No other text should be 

included in the header or footer unless noted elsewhere in these specifications.  

3.4 Page Numbers 

Page numbers begin with the Contents page. Use automatic page numbering fields. Place page 

numbers outside the margin and in the center of the footer of the page as it is read (on the short 

edge for portrait-oriented pages and on the long edge for landscape-oriented pages). Number the 

front matter pages starting with the Contents page consecutively with lowercase Roman 

numerals (i, ii, iii, etc.). Number the body of the report and back matter pages consecutively with 

Arabic numerals (1, 2, 3, etc.). Pages should be numbered consecutively whether the page 

number is expressed or not. When a page only contains illustrations or tables, the page number 

should not be expressed. Ensure that page numbers in the PDF file (including the page numbers 

shown in the status bar) match those in the Microsoft® Word file. 

3.5 Printed Reports 

Printed versions of the report should be printed double-sided on white letter-sized paper. When 

printing the document, a blank page may be inserted before and after the title page. A blank page 

does not need to be added after sections that end on an odd numbered page. The back cover 

should be printed facing outward.  
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4 Report Sections 

Each section within the report should start at the top of the page and be followed by a section 

break. Subsections do not need a section break and should immediately follow the preceding 

text. 

4.1 Front Cover 

Use the Template to generate the front covers of OSPD reports. The position and size of the 

BSEE logo and other elements may not be altered. For correct alignment, some cover elements 

are in borderless tables.  

 

Using artwork on the front cover is optional. Artwork that exemplifies the research is 

encouraged. The cover art may fill the available space between the title and the authors’ names. 

 

At the bottom of the page, above the footer, include the name of the authors in the order in which 

they are presented on the original report.  

 

Identify “US Department of the Interior,” “Bureau of Safety and Environmental Enforcement,” 

and “Oil Spill Preparedness Division” in the footer of the page. This element is aligned one inch 

from the bottom of the page. The size and position of the footer should not be changed and 

should be the same as the Template. 

 

Do not put logos other than BSEE’s on the cover page. Additional logos for studies conducted 

through inter/intra-agency agreements and cooperative agreements may be added with the 

COR’s or CO’s consent. This element is aligned 1.0 inch from the bottom of the page. 

4.2 Title Page 

Use the Template to generate the title page. For correct alignment, some elements in the 

Template are in borderless tables. Do not change the size of elements or their position relative to 

one another. White space between the “Title,” “OSRR #” “Authors,” and “Prepared” elements 

may be adjusted as necessary. 

 

Add the title to the top of the page. Cite the publication date of the report as month/year where 

the date is listed on the title page of the Template. Under “Authors,” list the authors or editors as 

appropriate. Additional authors may be listed following the same format. Where “Prepared 

under” appears, cite the type of award (contract, interagency agreement, intra-agency agreement, 

or cooperative agreement) and the award number. Include the contractor’s name and address 

under “By”. Additional contractors may be included, following the prime contractor. 

 

The logos of organizations partnering with BSEE OSPD to develop the report may be placed on 

the title page. Partner logo(s) may be the same size as or smaller than the BSEE logo. Add the 

logo(s) on the right side of the page, adjacent to the partner’s name.  

 

Copyright notice on the title page is optional. A work produced exclusively by government 

employees within their official duties is not protected under US copyright law and there for no 
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copyright notice should be included in this case. When a work is developed with joint authorship 

between US government employees and non-federal colleagues, the work is protected by 

copyright. The ownership of the copyright depends on the terms of the contract. The copyright 

notice should be placed directly under the OSRR # using the following format: 

 

© YYYY Copyright holder 

 

Identify “US Department of the Interior,” “Bureau of Safety and Environmental Enforcement,” 

and “Oil Spill Preparedness Division” in the footer of the page. This element is aligned one inch 

from the bottom of the page and should be in Arial 11 pt bold. The size and position of the footer 

should not be changed and should be the same as the Template. 

 

When printing the document, a blank page may be inserted before and after the title page. 

4.3 Notices 

The notices page includes the disclaimer statement, report availability information, suggested 

citation, cover graphic/photo credits (optional), and acknowledgments (optional). This page 

follows the title page, precedes the Contents, and has no page number. 

4.3.1 Disclaimer Statement 

A disclaimer statement is required in reports produced by non-BSEE authors or 

organizations. Include one of the following statements based on the type of award, filling in 

the appropriate text and numbers where indicated. 

Contracts: 

Study concept, oversight, and funding were provided by the US Department of the Interior 

(DOI), Bureau of Safety and Environmental Enforcement (BSEE), Oil Spill Preparedness 

Division (OSPD), Sterling, VA, under Contract Number _________________. This report 

has been technically reviewed by BSEE, and it has been approved for publication. The 

views and conclusions contained in this document are those of the authors and should not 

be interpreted as representing the opinions or policies of the US Government, nor does 

mention of trade names or commercial products constitute endorsement or 

recommendation for use. 

Interagency and Intra-Agency Agreements (select “Interagency” for agreements with 

Agencies outside of the US Department of the Interior (DOI) or “Intra-Agency” for Agencies 

within DOI): 

This study was funded, in part, by the US Department of the Interior, Bureau of Safety 

and Environmental Enforcement (BSEE), Oil Spill Preparedness (OSPD), Sterling, VA, 

through [Interagency or Intra-Agency] Agreement Number _________________ with the 

_________________. This report has been technically reviewed by BSEE, and it has been 

approved for publication. The views and conclusions contained in this document are those 

of the authors and should not be interpreted as representing the opinions or policies of the 

US Government, nor does mention of trade names or commercial products constitute 

endorsement or recommendation for use. 
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Cooperative Agreements: 

Study collaboration and funding were provided by the US Department of the Interior 

(DOI), Bureau of Safety and Environmental Enforcement (BSEE), Oil Spill Preparedness 

(OSPD), Sterling, VA, under Agreement Number _________________. This report has 

been technically reviewed by BSEE, and it has been approved for publication. The views 

and conclusions contained in this document are those of the authors and should not be 

interpreted as representing the opinions or policies of the US Government, nor does 

mention of trade names or commercial products constitute endorsement or 

recommendation for use. 

4.3.2 Report Availability 

Include the following statement and table on how to obtain a copy of the report.  The three 

sources listed below are required. Include the appropriate information under the search term for 

each document source.  If available, list other sources for the report and associated information: 

 

The PDF file for this report is available through the following sources. Click on the URL and 

enter the appropriate search term to locate the PDF:  

 

Document Source Search Term URL 

Bureau of Safety and 

Environmental Enforcement 

(BSEE) 

Project Number - 

[####] 
https://www.bsee.gov/what-we-do/research/oil-spill-

preparedness/oil-spill-response-research  

U.S. Department of the Interior 

Library 

[Project Title] https://library.doi.gov/uhtbin/cgisirsi/?ps=8L0mpW5uPV/SI

RSI/X/60/495/X 

National Technical Reports 

Library 

[Project Title] https://ntrl.ntis.gov/NTRL/  

Sources: a) BSEE (2019), b) DOI [2021], c) National Technical Information Service (2021) 

4.3.3 Citation 

Include a suggested citation for the report on the Notices page. Use the same format as the 

document references but include all of the authors’ names in this citation. Use the CSE 8th Edition 

(CSE 2014) format for this citation. For additional citation format examples, see the Scientific 

Style and Format Citation Quick Guide (CSE c2014). 

 

Citation format for technical report produced by a contractor or partner and published by 

BSEE:  

 

Lastname IN, Lastname IN, Lastname IN (Contractor name, City, ST). Year. Report title in 

sentence caps. City (ST): U.S. Department of the Interior, Bureau of Safety and Environmental 

Enforcement. xx p. Report No. xxxx. Contract No.: xxxxx. 

Citation example: 

 

Shigenaka G, Overton E, Meyer B, Gao H, Miles S. (NOAA, Seattle, WA) 2015. Comparison 

of physical and chemical characteristics of in situ burn residue and other environmental oil 

samples collected during the Deepwater Horizon spill responses. U.S. Department of the 

https://www.bsee.gov/what-we-do/research/oil-spill-preparedness/oil-spill-response-research
https://www.bsee.gov/what-we-do/research/oil-spill-preparedness/oil-spill-response-research
https://library.doi.gov/uhtbin/cgisirsi/?ps=8L0mpW5uPV/SIRSI/X/60/495/X
https://library.doi.gov/uhtbin/cgisirsi/?ps=8L0mpW5uPV/SIRSI/X/60/495/X
https://ntrl.ntis.gov/NTRL/
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Interior, Bureau of Safety and Environmental Enforcement. 41 p. Report No.:1010. Contract 

No.: E13PG0000120. 

4.3.4 About the Cover 

This section is optional and may be included for the cover photo credit.  The photo credit may 

also be listed under Acknowledgements (see Section 4.4.5). 

 

About the Cover example: 

 

Cover image by BSEE.  OSRR Project 1101 - “Testing of the Active Ice Management System at 

Ohmsett in a 70% ice field used to improve Arctic oil spill recovery.” 

 
4.3.5 Acknowledgments 

Acknowledgments are optional and may be included on the Notices page after all other elements 

or, if additional space is needed, on a separate page immediately after the disclaimer page.  

4.3.5.1 Copyrighted Material 

Copyrighted material (including photographs and figures) cannot be used unless authorized in 

writing by the copyright holder. Provide a copy of each authorization to the COR with the draft 

report. Copyright permissions should be listed under Acknowledgements. 

4.4 Graphical Abstract 

A Graphical Abstract is required. Insert a single, concise, pictorial and visual summary of the 

project’s main [significant] findings. The Graphical Abstract should capture the content of the 

project report for readers at a single glance. See an example published Graphical Abstract below. 

The Graphical Abstract should be followed by a page break. 

 

Graphical Abstract Image size: Include an image with a minimum of 531 × 1328 pixels (h × w) 

using a minimum resolution of 300 pixels per inch(ppi), highest resolution possible is preferred. 

The image should be scaled proportionally to fit within the page margins.  Check the resolution 

details of your image by saving the image on your computer. Right click on the File> Properties> 

Details> Image.  

 

No additional text, outline or synopsis should be included for the Graphical Abstract. However, 

for Section 508 compliance, provide an “alt text”1 description for the Graphical Abstract that 

provides a brief description of what is shown. Right click on the image and select “Edit Alt Text” 

to add a description. Text within a graphical abstract must meet color contrast standards. 

Standard text less than 12 pt regular must have a contrast ratio of 4.5 :1. Large text (14 pt bold or 

18 pt regular) must have a contrast ratio of 3:1.  

 

Example Reference: Elsevier Science Authors Instructions: 

https://www.elsevier.com/authors/journal-authors/graphical-abstract  

 
1 Alternative text, or alt text, provides a description to an image or figure that a screen reader uses to describe what 

is being shown. This provides context to images for those who may be visually impaired. It can also be useful for 

those who encounters a broken image or disables image loading. 

https://www.elsevier.com/authors/journal-authors/graphical-abstract
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Kaminskasa L, Porter C.J.H. 2011.Targeting the lymphatics using dendritic polymers 

(dendrimers). Advanced Drug Delivery Reviews, 63:10-11. [accessed 2021 Apr 07] 

http://dx.doi.org/10.1016/j.addr.2011.05.016. 

 

4.5 Executive Summary 

In this section include an Executive Summary about the study.  The Executive Summary should 

be concise, written in plain language, and provide an overview about the research in 

approximately 500-1,000 words. The summary should be followed by a page break. 

4.6 Contents and Other Front Matter Lists 

Include a table of contents (labeled “Contents”). In the Contents, include the first three levels of 

section headings with correct page numbers. Include any appendixes in the Contents. Provide 

separate lists for figures and tables. These lists follow the Contents and are to be referenced in 

the Contents. Generate these lists using the references features in Microsoft® Word. 

4.7 Report Body 

See Section 5 of these specifications for guidance on report body style. See Chapter 7 in the CSE 

8th Edition (CSE 2014) for guidance on prose style and word choice. 

4.8 References 

Contractors should use in-text and end references and are encouraged to do so using EndNote or 

other similar software or the citation function in Microsoft® Word. In the end references, include 

http://dx.doi.org/10.1016/j.addr.2011.05.016
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every source referenced or quoted in the report, including unpublished material, personal 

communications, and references cited in figures and tables. 

 

Use a Name-Year reference system consistently throughout the document. In-text and end 

references in this document are in the recommended format of the CSE 8th Edition (CSE 2014). 

For citation format examples, see the Scientific Style and Format Citation Quick Guide (CSE 

c2014). Additional CSE 8th Edition citation format samples can be found in Appendix B. 

4.9 Appendixes 

A report may have appendixes as needed for supplemental information. Include appendixes in 

the Contents. If a report has more than one appendix, number or letter them consecutively. 

Appendixes should be placed after the References preceded by a half-title page labeled 

“Appendix” or “Appendixes” as appropriate. 

4.9.1 Technical Summary  

A technical summary is required for each report and must be the first item listed in the Appendix. 

Refer to the technical summary in the Template for required elements.  The order of the required 

elements should follow the Template.  

4.10 Abbreviations, Acronyms, and Symbols 

Spell out acronyms and abbreviations on first use in the text. Use an acronym if the phrase it 
represents appears more than three times in the document or if the acronym is more commonly 
known than the phrase. Abbreviations in common use do not need to be included in the list of 
abbreviations. 

 

If the document includes five or more abbreviations, acronyms, and/or symbols, include an 

alphabetical list of them in left-aligned columns (a borderless table is recommended), in the 

back matter of the report. This list is placed after the Appendix. 

4.11 Back Cover 

Place the DOI and BSEE logos and mission statements on the back cover as shown on the last 

page of the Template. The layout and wording of the back cover is shown exactly in these 

specifications and the accompanying Template, with no alterations permitted. Place the back 

cover facing outward when formatting for printing. 

4.12 Multiple Volumes 

If the report is very long, it may be prepared in multiple volumes. Number multiple volumes 

consecutively and list all volumes in the Contents. Each separate volume must have front and 

back covers, a disclaimer page, a title page, Contents and other front matter lists, and references 

as described in this document. Volumes should be numbered consecutively started with Arabic 

numeral 1. Each volume should have the same title, volumes may be differentiated by adding a 

subtitle. The volume should be listed under the title on both the cover and title page.  
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5 Report Body Style Specifications 

Use consistent formatting throughout the document. When printing, a blank page does not need 

to be added between sections. 

5.1 Spacing 

• Use single line spacing. 
• Use spacing between paragraphs as set by the paragraph styles. 
• Use one space after end-of-sentence punctuation. 

5.2 Paragraph Formatting 

• Set body text paragraph justification to left justified with a ragged right margin. 
• Use 0 pt space before and after the paragraph with the box checked for “Don’t add 

spaces between paragraphs of the same style.” 

• “Widow/Orphan control” should be used. This option is located in the Paragraph section 

under Line and Page Breaks tab. 

5.3 Fonts 

• Use the paragraph and character styles provided in the Template.  

• Do not change the style settings provided by BSEE. Add new styles only if necessary. 

• The body text should be 12 point, Times New Roman. 

• Titles and Section Titles should be Arial font using the font size listed in the Template. 

5.4 Numbers 

• Separate every three digits to the left of the decimal point with a comma (e.g., 1,234). 

• Do not use a separator comma in the numbers after a decimal and where the use of a 

comma is inappropriate, such as in a US ZIP code. 
• Use a period (not a comma) as a decimal point. 
• For numbers less than 1.0, use a zero to the left of the decimal point (e.g., 0.12). 
• List dates in the sequence of day, month, and year (e.g., 23 April 2021). 

5.5 Units 

• Metric units are preferred, but the standard unit for the discipline may be used. 

• Maintain consistency in the units throughout the report. If a change in the unit is 

required, it must be clearly stated to avoid confusion. 

• If appropriate, both standard and metric units may be provided by adding standard units 

in parenthesis. (e.g. 12.2 to 15.2 m (40 ft to 50 ft)) 

5.6 Hyperlinks 

• Avoid adding hyperlinks and URLs in the body of the report when possible. 

• Treat Internet-based documents like references; cite them in the text and include 

them in the References list. 
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• If used, URLs must be correct, complete, and linked to an active webpage. Provide a 
ScreenTip2 for each URL. 

5.7 Figures and Tables 

• Insert figures and tables as closely as possible after the text that refers to them. 

• If there are many consecutive figures or tables, or if a single figure or table 

occupies multiple pages (and so disrupts the continuity of the text of the report), 

these figures or tables may be grouped at the end of the chapter or placed in an 

appendix. 

• Figure captions appear below the figure; table titles appear above the table. Figure 

captions and table titles appear on the same page as the figure or table, are left 

justified, and in bold text. 
• Include spacing above and below figures, tables, and the associated text. 

• To keep the caption or title length to a minimum, use the caption or title to provide a 

unique number and descriptive name, not to explain the figure or table. Discuss the 

meaning of the figure or table in the corresponding body text or in a note beneath the 

figure or table. 
• Figure captions and table titles are single phrases with sentence-style capitalization. 
• Acronyms are permitted if they were spelled out ahead of the figure or table. 

• Footnote references are not permitted in the title caption. Include references just 

below the figure or table. 

5.7.1 Figures 

• Provide the individual file for each figure to BSEE OSPD with the final report. 
• The minimum resolution for graphic files is 300 ppi. In File > Options > Advanced, set 

the default resolution to 300 ppi and check the box for “do not compress images.” For 
Section 508 compliance, provide an alternative text description for each figure if the 
figure caption and notes do not sufficiently describe the contents. 

• Set the text wrapping style (when you click on the image, use the Layout Options icon) 
to “in line with text.” 

• Use the Figure Caption and Figure Notes styles within the Report Template for the 
caption and description of the figure respectively.  

• Photo credit can be given in the following format at the end of the figure caption (Photo: 
Organization, Year) 

• Figure 1 provides a sample figure to show the caption and description (if desired) as 
flush left. 

• When more than one figure is included in the report, label each figure caption as “Fig.” 
and number them consecutively in Arabic numerals. For example: Fig. 1, Fig. 2 

• Figure notes should consist of a short phrase without a closing period in sentence case. 

5.7.2 Tables 

• Use the table style as shown in the Template. 

 
2 ScreenTips can be added in Microsoft® Word by going to the Insert tab and clicking the Link icon. The URL can 

be added to the address line and the text to display should remain unchanged. The ScreenTip can be added by 

clicking on the ScreenTip button next to the Text to Display bar. The ScreenTip text should describe where the link 

leads.  
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• Tables may include footnotes at the bottom of the table. 
• Tables must include units where applicable. 

• Even if the table fits on one page and does not break across pages, select the 

following table properties: 
o Repeat header row on every page of the table 
o Do not allow table rows to break across pages 

• Align numbers in a column on the decimal point (see example in Appendix B).  
o Use the “Table Cell (left)” style.  
o Select the cells you want to align.  
o Double click on the lower part of the ruler around the place you want to put the 

decimal (or go to Paragraph > Tabs and enter an amount for the distance of the 
decimal from the left cell margin).  

o Select “Decimal,” “Set,” and “OK.”  
• Per Section 508 requirements, leave cells empty if there is no content; do not merge or 

split cells. 

Fig. 1 P16400 Marco skimmer  
A combined team of personnel from Navy SUPSALV and Global PCCI measure the capabilities of P16400 Marco 
Class V Skimmer Vessel equipped with an Elastec Grooved X-Disc at Ohmsett (Photo: BSEE, 2021) 

Fig. 2 MC 252 Target aromatics 
Target analyte profiles for aromatics in fresh MC2552 source oil (riser fluid) (Shigenaka, 2015) 
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5.8 Endnotes and Footnotes 

• Endnotes may be shown in a smaller font size than the body text but must be at least 9 

pts in size. 
• Use a consistent style for all endnotes. 
• Put the endnote section at the end of each volume before the References section. 

• Endnotes and end references are preferred, but footnotes may be used if appropriate for 

the area of study. 

• Footnotes can be added by using the Footnotes feature under the References tab in 

Microsoft® Word. 
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Appendix A: Technical Data Specifications 

A.1 Purpose 

The Appendix is a back matter section to include relevant project/contract details including 

detailed data, tables, graphs, charts, and other supporting images. 

A.2 Required Elements 

At a minimum, the following informational elements shall be included in the Appendix. 

REPORT TITLE:  

CONTRACT NUMBER(S):  

FISCAL YEARS(S) OF PROJECT FUNDING:  

CUMULATIVE PROJECT COST:  

COMPLETION DATE OF REPORT:  

BSEE COR(S):  

BSEE CO(S):  

PROJECT MANAGER(S):  

AFFILIATION OF PROJECT MANAGER:  

ADDRESS:  

PRINCIPAL INVESTIGATOR(S)*:  

KEY WORDS 

 

* The affiliation of the Principal Investigators(s) may be different than that listed for Project 

Manager(s). 

A.3 Optional Elements 

Optional elements include any additional information, data, or exhibits that support or amplify 

text contained in the report.  These elements could include tables, figures, maps, text, etc. 
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Appendix B: Council of Science Editors 8th Edition Bibliography 
Formatting Examples  

This appendix provides examples of CSE 8th Edition references (in Name-Year format) that are 

commonly found in environmental study reports. Items in works cited or reference lists should 

not break across pages. 

B.1  Technical Report 

Authors(s). Year. Title of report in sentence caps. Edition. Place of publication: Publisher. 

Extent. Report No.: xx. Contract No.: xx. Notes. 

Feller BA. 1981. Health characteristics of persons with chronic activity limitations. United 

States, 1979. Hyattsville (MD): National Center for Health Statistics (US). 68 p. 

Report No. VHS- 2345. Available from: NTIS, Springfield, VA; PB88-284858. 

Sheridan P. 2008. Seasonal foods, gonadal maturation, and length-weight relationships for 

nine fishes commonly captured by shrimp trawl on the northwest Gulf of Mexico 

continental shelf. Panama City Beach (FL): National Marine Fisheries Service, 

Southeast Fisheries Science Center. 40 p. Report No.: NOAA Tech. Memo. NMFS-

SEFSC-566. 

Written by a Performing Organization and Published by a Sponsoring Organization or Agency 
 

Authors(s) (performing org [contractor] name, City, ST). Year. Title of report in sentence 

caps. Edition. Place of publication: Publisher. xx p. Report No.: xx. Contract No.: xx. 

Grant No.: xx. Notes. 

Ford B, Borgens A, Bryant W, Marshall D, Hitchcock P, Arias C, Hamilton D (Texas 

A&M University, College Station, TX). 2008. Archaeological excavation of the 

Mardi Gras Shipwreck (16GM01), Gulf of Mexico Continental Slope. New 

Orleans (LA): U.S. Department of the Interior, Minerals Management Service. 

326 p. Report No.: OCS Report MMS 2008-037. Contract No.: 1435-01-04-CA-

32806-39902 (M08AC12864). 

Jochens A, Biggs D, Benoit-Bird K, Engelhardt D, Gordon J, et al. (Texas A&M University, 

College Station, TX). 2008. Sperm whale seismic study in the Gulf of Mexico: 

synthesis report. New Orleans (LA): U.S. Department of the Interior, Minerals 

Management Service. 500 p. Report No.: OCS Study MMS 2008-006. Contract No.: 

1435-01-02-CA-85186. 

Stunz GW, Ajemian MJ, Streich MK, Brewton R, Downey C, et al. Texas A&M 

University–Corpus Christi Hate Research Institute for Gulf of Mexico Studies, 

Corpus Christi, TX). 2016. Investigation of the relative habitat value of oil and/or 

gas platforms and natural banks in enhancing stock building of reef fish in the 

western Gulf of Mexico. St. Petersburg (FL): National Marine Fisheries Service, 

Southeast Regional Office. 109 p. Grant No.: NA14NMF4330219. Report No.: 

SEDAR52-RD-02. 
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Wood J, Southall BL, Tollit DJ (Environmental Resources Management [ERM] Group, 

Inc.). 2012. PG&E offshore 3‐D seismic survey project EIR–marine mammal 

technical draft report. St. Andrews (GB)3: SMRU Ltd. 78 p. Report No.: 

SMRUL‐NA0611ERM. 

B.2 Article in a Journal 

Author(s). Year. Article title in sentence caps. Journal title [use ISO 4 journal 

abbreviations for titles of journals4]. Volume(issue): location. 

Conmy, RN, Coble PG, Farr J, Wood AM, Lee K, Pegau S, Walsh I, Koch C, Abercrombie 

MI, Miles MS, Lewis M, Ryan S, Robinson B, King T, Kelble C, and Lacoste J. 

2014. Performance of submersible fluorometers exposed to chemically-dispersed 

crude oil: Wave tank simulations for improved oil spill monitoring and evaluation of 

Deepwater Horizon spill measurements. Environmental Science and Technology 

48(3):1803–1810. 

Article Accepted for Publication and in Review 
 
If the article has been accepted for publication, designate as “Forthcoming.” as in Author. 

Forthcoming Year. Article title. Journal name, etc. If it has been submitted but not yet 

accepted, *and* it is available to the public, treat it as an unpublished manuscript. 

Roulee RA, Getty RG, Rascal CA, Peterson AD. Forthcoming 2020. Listening to 

fish: passive acoustics and fisheries science. Fisheries. 

(Roulee et al. Forthcoming 2020) 

B.3 Book 

Author(s). Year. Title of book in sentence caps. Edition. Place of publication: 

Publisher. Extent [optional]. Notes. 

Richardson WJ, Greene Jr CR, Malme CI, Thomson DH. 1995. Marine mammals and 

noise. San Diego (CA): Academic Press. 502 p. 

Multi-volume Book When All Volumes Are Referenced 
 

Mica WJ, Baca Jr CR, Malme CI, Thomson DH. 1995. Marine mammals and family 

hierarchy. San Mateo (CA): Blimey Press. 4 vol. 

 
3 Two-letter ISO Country Codes, see the full list at https://www.iso.org/obp/ui/#search 
4 The full list of journal title abbreviations: https://www.issn.org/services/online-services/access-to-the- 

ltwa/?lettre=s#recherche 

https://www.iso.org/obp/ui/#search
https://www.issn.org/services/online-services/access-to-the-ltwa/?lettre=s&amp;recherche
https://www.issn.org/services/online-services/access-to-the-ltwa/?lettre=s&amp;recherche
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Part of Book When Author of the Part Is Same as Book Author 
 

Bobsled IL, Pratt YN. 2009. Marine mammals and ocean noise. Wilmington (NC): 

University of North Carolina-Wilmington. Chapter 4: Toothed whales; p. 70–

97. 

Part of a Book When the Author is Not the Author or Editor of the Book 
 

Author(s). Year. Title of part or chapter in sentence caps. In: Editors names, editors. 

Name of the book. Edition [ed.]. Place of publication: publisher. Extent of cited part or 

chapter. 

Andriolo A, de Castro FR, Amorim T, Miranda G, Di Tullio J, et al. 2018. Marine 

mammal bioacoustics using towed array systems in the western South Atlantic 

Ocean. In: Rossi-Santos MR, Finkl CW, editors. Advances in marine vertebrate 

research in Latin America. Vol. 2. Cham (CH): Springer International Publishing 

AG. p. 113–147. 
 

Ludwig S, Kreimeyer R, Knoll M. 2016. Comparison of PAM systems for acoustic 

monitoring and further risk mitigation application. In: Popper A, Hawkins A, 

editors. The effects of noise on aquatic life II: advances in experimental medicine 

and biology. Vol 875. New York (NY): Springer. p. 655–663. 

Book in a Series 
 

Salvador A. 1991. Origin and development of the Gulf of Mexico Basin. In: Salvador A, 

editor. The Gulf of Mexico Basin. The geology of North America, Volume J. Boulder 

(CO): Geological Society of America. p. 389–444. 

Contribution to a Book [Author of the Contribution is Not Author or Editor of Book] 
 

Hazeltine WA. 2009. Kidney disease. In: Michaelson PE, Odetta LF, editors. The 

encyclopedia of medicine. Berlin (DE): Verlag. p. 365–390. 

Stanley DR, Wilson CA. 2003. Seasonal and spatial variation in the biomass and size 

frequency distribution of fish associated with oil and gas platforms in the 

northern Gulf of Mexico. In: Stanley DR, Scarborough-Bull A, editors. Fisheries, 

reefs, and offshore development. American Fisheries Society Symposium 36. 

Bethesda (MD): American Fisheries Society. p. 123–153. 

B.4 Conference Proceedings and Poster Presentations 

These are one of the only formats that takes title caps (for the proceedings and the conference 

titles). 



 

19 

Conference Paper in Published Proceedings 
 
Author(s) of paper. Year. Title of paper in sentence caps. In: Title of Book in Title Caps. 

Number and name of conference; date of conference; place of conference. Place of 

publication: publisher. Location. Notes. 

Coolbaugh T, Nicoll A, Montgomery A, Varghese G, Heathcote L. 2017. Effective 

planning for dispersant operations – Making decisions, analyzing options and 

establishing capability. In: International Oil Spill Conference Proceedings, Vol 1. 

2017 May 15-18, Long Beach, CA, p. 2791-2810. https://doi.org/10.7901/2169-

3358-2017.1.2791. 

Yoshioka R, Salem A, Swerdon S, Loper C, Pritchett Z. 2016. Turning FPUs into hubs: 

opportunities and constraints. Proceedings of the Annual Offshore Technology 

Conference, Vol. 1; 2016 May 2–5; Houston, TX. Richardson (TX): Offshore 

Technology Conference. p. 3249–3257. OTC-27167-MS. doi:10.4043/27167-MS. 

Published Proceedings (Entire Proceedings) 
 

Author(s) of paper. Year. Title of book in title caps. Number and name of conference; date 

of conference; place of conference. Place of publication: publisher. Location. Notes. 

Callaos N, Malmgern K, Cooke J, editors. c2003. Proceedings of the 7th World 

Multiconference on Systemics, Informatics, and Cybernetics. SCI: 7, 2003; 2003 

Jul 27–30; Orlando, FL. Orlando (FL): International Institute of Informatics. 

Unpublished Conference 
 

Author. Year of conference. Title of paper in sentence caps. Paper presented at: Title of 

conference. Number and name of conference: Place of conference. 

Beppo KL, Svoboda TR. 2018. Assessments of congregations of red fish at drilling 

platforms in the Gulf of Mexico. Paper presented at: Where Things Stand: Gulf of 

Mexico 5th Annual Species Status Conference; 2016 Nov 10–14; Biloxi, MS. 

Poster or Paper Presentation 
 

Bourque JR, Demopoulos AWJ, Fisher CR. 2015. Temporal variability of deep-sea coral-

associated macrofauna in the Gulf of Mexico after the Deepwater Horizon oil spill. 

Poster presented at: 14th Deep Sea Biology Symposium; 2015 Aug 13 ֪–Sep 04; 

Aveiro, Portugal. 

Rowe J, Morandi A, Li Z, Blanc P. 2017. Oil spill response technologies (OSR) since 

Macondo – A review of improvements and novelties. Paper presented at: 

International Oil Spill Conference, 2017 May 15-18, Long Beach, CA.  

https://doi.org/10.7901/2169-3358-2017.1.2791
https://doi.org/10.7901/2169-3358-2017.1.2791
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Wells, S, Tupelo P, Edmonson S. 2019. Variability of oyster beds in the Gulf of Mexico 

after the Deepwater Horizon oil spill. Paper presented at: 14th Deep Sea Biology 

Symposium; 2018 Aug 13֪–Sep 04; Madrid, Spain. 

B.5 Dissertation or Thesis 

Author(s). Year. Title of dissertation or thesis in sentence caps [content designator]. 

Place of publication: publisher. Extent. 

Evans AM. 2012. Out of site but not out of mind: submerged landscapes on the 

northwestern Gulf of Mexico Outer Continental Shelf [dissertation]. Baton Rouge: 

Louisiana State University. 

B.6 Maps 

Author, cartographer. Year. Title of map in sentence caps [map type]. Place of 

publication: publisher. Physical description. Notes. 

Heinrich PV, Snead J, cartographers. 2003. Crowley 30 × 60 minute geologic 

quadrangle. Baton Rouge (LA): Louisiana Geological Survey. Scale 

1:100,000. 

Winker CD, compiler. 1990. Quaternary geology, northwestern Gulf Coast. In: Morrison 

RB, editor. Quaternary non-glacial geology: conterminous United States. The 

geology of North America, volume K-2. Boulder (CO): Geological Society of 

America. Plate 8. Scale 1:2,000,000. 

B.7 Websites and Other Online Formats 

References to websites and other online formats follow the same general principles as for 

printed references, with the addition of a date of update and/or revision (if available) along 

with an access date and a web address. NOTE: Providing only a web address is NOT 

sufficient. 

Website 
 
Title of Homepage. Year. Edition. Place of publication: publisher; [date updated; date 

accessed]. Notes. 

 

If no date of publication can be determined, use a copyright date (if available), preceded by 

“c”. Include the web address in the notes. 

GNOME. c2018. National Oceanic and Atmospheric Administration (NOAA). 

[accessed 2018 Mar 7] https://response.restoration.noaa.gov/oil-and-

chemical-spills/oil-spills/response-tools/gnome.html. 

For the in-text reference, include only the first word or two of the title (enough to distinguish it 

from other titles in the reference list), followed by an ellipsis. 

(GNOME c2018) 

https://response.restoration.noaa.gov/oil-and-chemical-spills/oil-spills/response-tools/gnome.html.
https://response.restoration.noaa.gov/oil-and-chemical-spills/oil-spills/response-tools/gnome.html.
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Online Data or Datasets 
 

Seaturtle.org. c2017a. Buck Island turtles [dataset]. Durham (NC): Duke 

University, Ocean Biogeographic Information System Spatial Ecological 

Analysis of Megavertebrate Populations; [accessed 2017 Jun 20]. 

http://www.seaturtle.org/tracking/index.shtml?project_id=663. 

(Seaturtle.org c2017a) 

Seaturtle.org. c2017b. Satellite tracking: Alabama sea turtles. Durham (NC): US 

Department of the Interior, US Geological Survey National Resource Damage 

Assessment; [accessed 2017 Jun 20]. 

http://www.seaturtle.org/tracking/?project_id=627. 

(Seaturtle.org c2017b) 

Journal Article (if also available online) 
 

Perkins S. 2006. Intrepid explorer: An oceangoing rover gathers unprecedented data. 

Science News Online, 170(5):72. [Accessed 2007 Dec 27]; 

http://www.sciencenews.org/articles/20060729/bob9.asp. 

Online Journal Article 
 
Author(s) of article. Year. Title of article in sentence caps. Title of journal (edition). 

Volume(issue):location. [date updated; date accessed]; web address. Notes. 

 

A DOI (Digital Object Identifier) may be included in the notes in addition to a web address, if 

available: 

Savage E, Ramsay M, White J, Beard S, Lawson H, Hunjan R, Brown D. 2005. Mumps 

outbreaks across England and Wales in 2004: observational study. BMJ. 

330(7500):1119–1120. [accessed 2005 May 31]; 

http://bmj.bmjjournals.com/cgi/reprint/330/7500/1119. 

doi:10.1136/bmj.330.7500.1119. 

Online Report 
 
Author(s) of article. Year. Title of article in sentence caps. Place of publication: Publisher. 

Extent. Report No.: xx. Contract No.: xx. [date updated; date accessed]; 

Volume(issue):location. Notes. 

Schirripa MJ, Legault CM. 1999. Status of the red snapper in U.S. waters of the Gulf of 

Mexico: updated through 1998. Miami (FL): National Marine Fisheries Service, 

Southeast Fisheries Science Center. 106 p. Report No.: SFD-99/00-75. [accessed 

2020 March 30]; https://grunt.sefsc.noaa.gov/P_QryLDS/download/SFD76_SFD-

99_00-75A.pdf?id=LDS 

http://www.seaturtle.org/tracking/index.shtml?project_id=663
http://www.seaturtle.org/tracking/?project_id=627.
http://www.seaturtle.org/tracking/?project_id=627.
http://www.sciencenews.org/articles/20060729/bob9.asp
http://bmj.bmjjournals.com/cgi/reprint/330/7500/1119
https://grunt.sefsc.noaa.gov/P_QryLDS/download/SFD76_SFD-99_00-75A.pdf?id=LDS
https://grunt.sefsc.noaa.gov/P_QryLDS/download/SFD76_SFD-99_00-75A.pdf?id=LDS
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[SEDAR] Southeast Data, Assessment, and Review. 2005. Stock assessment report of 

SEDAR 7: Gulf of Mexico red snapper. SEDAR7 assessment report 1. Charleston 

(SC): SEDAR. 480 p. [accessed 2020 March 30]; 

http://sedarweb.org/docs/sar/S7SAR_FINAL-redsnapper.pdf 

Online Database 
 
Title of database in sentence caps. Beginning date–ending date. Edition. Place of 

publication: Publisher. [date updated; date accessed]. Notes. 

e-Book 

 
Author(s). Year. Title of book in sentence caps. Edition. Place of publication: publisher; 

[date updated; date accessed]. Notes. 

Brogden KA, Guthmille JM, editors. 2002. Polymicrobial diseases. Washington (DC): 

ASM Press; [accessed 2014 Feb 28]. 

http://www.ncbi.nlm.nih.gov/books/NBK2475/. 

Blog 
 
Author(s). Year. Title of post in sentence caps [descriptive word]. Title of blog. [accessed 

date]. Web address. 

Fogarty M. 2012 Aug 14. Formatting titles on Twitter and Facebook [blog]. Grammar Girl: 

Quick and Dirty Tips for Better Writing. [accessed 2012 Oct 19]. 

http://grammar.quickanddirtytips.com/formatting-titles-on-twitter-and-

facebook.aspx. 

B.8 ISO Journal Title Abbreviations: Links 

If the full journal name is not listed, and some are not, just use the abbreviation for each word. 
 

Full list: 
 

• https://www.issn.org/services/online-services/access-to-the-ltwa/?lettre=s#recherche  

 

Other resources: 
 

• https://woodward.library.ubc.ca/research-help/journal-abbreviations/ 

• https://www.wsl.ch/en/publicationssearch/list-of-journal-abbreviations.html 

http://sedarweb.org/docs/sar/S7SAR_FINAL-redsnapper.pdf
http://www.ncbi.nlm.nih.gov/books/NBK2475/
http://grammar.quickanddirtytips.com/formatting-titles-on-twitter-and-facebook.aspx.
http://grammar.quickanddirtytips.com/formatting-titles-on-twitter-and-facebook.aspx.
https://www.issn.org/services/online-services/access-to-the-ltwa/?lettre=s#recherche 

https://www.issn.org/services/online-services/access-to-the-ltwa/?lettre=s#recherche 

https://woodward.library.ubc.ca/research-help/journal-abbreviations/
https://woodward.library.ubc.ca/research-help/journal-abbreviations/
https://www.wsl.ch/en/publicationssearch/list-of-journal-abbreviations.html
https://www.wsl.ch/en/publicationssearch/list-of-journal-abbreviations.html
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Appendix C: Sample Table in Landscape Orientation 

 

Table B-2 Sample table in landscape orientation with data in columns aligned on the decimal (mg/m2) 

Station chl c2 
Pheo-
phorbide 

Peridinin 
+isomer 

Pyropheo-
phorbide 

19-but 
fuxocantin 

fuxocanthin 
Prasino-
xanthin 

19-hex-
fuxocanthin 

zeaxanthin chl b chl a 
Pheo 
-phytin 

23 0.16 2.36 0.45 11.77 0.07 3.80 0.13 0.00 0.05 0.23 4.44 0.19 

24 0.11 1.30 0.23 1.38 0.01 2.39 0.00 0.00 0.01 0.13 2.37 0.00 

25 0.23 14.77 1.27 33.18 0.72 3.53 0.10 0.02 0.05 0.89 5.63 0.00 
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Abbreviations and Acronyms 

AUV Autonomous Underwater Vehicle 

BSEE Bureau of Safety and Environmental Enforcement 

CO Contracting Officer 

COR Contracting Officer’s Representative 

CSE Council of Science Editors 

DM Departmental Manual  

DOI Department of the Interior 

NRS National Response System 

NTRL National Technical Reports Library 

OSPD Oil Spill Preparedness Division 

OSRR Oil Spill Response Research 

ppi Pixels Per Inch 

PV Preparedness Verification  

Template Oil Spill Preparedness Division Report Template 
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 Department of the Interior (DOI) 

The Department of the Interior protects and manages the Nation's 

natural resources and cultural heritage; provides scientific and other 

information about those resources; and honors the Nation’s trust 

responsibilities or special commitments to American Indians, Alaska 

Natives, and affiliated island communities. 

 

Bureau of Safety and Environmental Enforcement (BSEE) 

The mission of the Bureau of Safety and Environmental Enforcement 

works to promote safety, protect the environment, and conserve 

resources offshore through vigorous regulatory oversight and 

enforcement. 

 BSEE Oil Spill Preparedness Program  

BSEE administers a robust Oil Spill Preparedness Program through its 

Oil Spill Preparedness Division (OSPD) to ensure owners and 

operators of offshore facilities are ready to mitigate and respond to 

substantial threats of actual oil spills that may result from their 

activities. The Program draws its mandate and purpose from the 

Federal Water Pollution Control Act of October 18, 1972, as amended, 

and the Oil Pollution Act of 1990 (October 18, 1991). It is framed by 

the regulations in 30 CFR Part 254 – Oil Spill Response Requirements 

for Facilities Located Seaward of the Coastline, and 40 CFR Part 300 – 

National Oil and Hazardous Substances Pollution Contingency Plan. 

Acknowledging these authorities and their associated responsibilities, 

BSEE established the program with three primary and interdependent 

roles:  

• Preparedness Verification, 

• Oil Spill Response Research, and  

• Management of Ohmsett - the National Oil Spill Response 

Research and Renewable Energy Test Facility.  

 

The research conducted for this Program aims to improve oil spill 

response and preparedness by advancing the state of the science and the 

technologies needed for these emergencies. The research supports the 

Bureau’s needs while ensuring the highest level of scientific integrity 

by adhering to BSEE’s peer review protocols. The proposal, selection, 

research, review, collaboration, production, and dissemination of 

OSPD’s technical reports and studies follows the appropriate 

requirements and guidance such as the Federal Acquisition Regulation 

and the Department of Interior’s policies on scientific and scholarly 

conduct. 
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